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Importance of the Data Model (Pl AF) — The Foundation
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Defining Analytics — “The Analysis of Analytics”

The Role of the PI Integrator for Higher Level Analytics
Enabling Operational Intelligence and Excellence
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The Journey to Enterprise Intelligence — IT/OT Convergence
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The PI System - Foundational for Operational Intelligence & Excellence
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New Uses for and Users of Pl System Data

ERP

Real-Time Retrospective &
Decision Predictive
AnalySiS OoMS Ana'ysis Y Market

CRM
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Weather Contracts

GIS WWE 1Y

MES Finance

Operational

Drivers to Expand
Pl Data

Infrastructure

Business Drivers to
Expand Pl System
Data Infrastructure

Pl System Data for:
Reporting, Analytics, Bl,
Business Processes...

Pl System Data for:
Process Monitoring,
Situational Awareness

Enterprise
Infrastructure
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Enabling Analytics for Operational Intelligence

Real-Time Decision Analysis Retrospective & Predictive Analysis

Pl Integrator for
Business Analytics

Time and Event
Trending & Awareness

Multidimensional
Business Intelligence

Specialized Models & Dashboards

Simulation & Optimization

Establishes Common Ground
between

APpp  kh P g
Q- oo <k OT and IT Contexts S =
141.2uBy {In 7= —§ + 5 Time, Event Tabular R m
and Asset Context )

e
=

' INCi Statistical
Flrgirzlr.:,:];:fel es Context Predictive Modelling
& Condition & Machine Learning
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First Principles Analytics - Performance & Condition

. . 2 2
 Relationships always H=z:1+24 ;"_ —h ;’_
exists between process L Py 49 g
measurements Daniel Bernoulli
(1700 — 1782) APpp * kh

* Requires synchronized 141.2uBy{ln 2~ § + 5}

observations for
meaningful results

PV =nRT

i | R+ 1'? xIn((1- SRY/ (1- S
Benoit Clapeyron _ ( )" xIn(( ) (1-S)

F =
(1799 — 1864) (l—R)xhl{J-s(R__1_(R+1}1131) }
2-S(R+1+(R=+1)")

« Enables real-time decision
making only when visible,
l.e. not performed in
spreadsheets P=1V=IR=—

James Watt
(1736-1819)

S
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First Principles Analytics - Pl Asset Analytics

Calculation Steps:

w, T, 1. Heat Duty, Q=gq, + o

Qs = Wx Cp %(Ti- To)/1000/3600

» Configure calculations at scale = ] rr S 2 wa o xeaooonsead
— 1

Cold fluid in Shell Hot fluid out
! W, T,

(&

Hot Fluid Pressure Drop. APRr= P, — P,

Cold fluid pressure drop. APe = pi- po

3
-~ Hot fluid in 4. Temperanure range hot fluid, AT = T,- T,

b M ath ) Stati Sti Cal ) Iog iCaI an d pame E‘O::l o l e 5. Temperahwe range cold fluid, At=1, —1;
St eam t ab I e fu n Ctl ons Heat Exchanger Key Performance Indicator: 6. Capacity ratio. R = W X Cpn / W X Cpe (1) (Ti- To) / (te~ 1)

Overall heat transfer coefficient 7. Effectiveness, S = (t,- ;) / (T; — t;)

B.
Q Flow = ({T;-! , M(Te=ti))
. . . S E w o ((Tiet) = (T )/ I (T ta))
° : ;u 0 rtS SI m Ie red ICtIVe A x corrected LMTD Correction factor for LMTD 1o account for Cross flow
R+ 1" xIn ((1- SRY (1- $ )
F =
- RULE: IF the heat transfer coefficient is decreasing. (1-R)xIn {: : ﬁ_ 1= ;;—; : L
an aI ICS THEN the Heat Exchanger FOULING 11! 2=S(R+H1+ER+DHTD )
Cleaining i=s required! 9. Comrected LMTD = F x LMTD
ST A AT
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* High Temperature Hydrogen Attack (HTHA)

File Sesrch View Go Tools Help

@ Database % QueryDate ~ © @ | (@ Back () |, Checkln 3« [2] Refresh | (3 New Element ~ 2] New Attribute Search Elements o~ .
Evmenict o bip domleis ceppogs HTHA » fX(metallurgy, temperature, hydrogen partial
B [ e —— pressure(PP), length of exposure)
0 aneus rter £ =[] name:

~ 6 Controlloops DR
g Crudi unitsﬁ | /4| /#|8/Name 2| vave % 4 | | Desciption:
~ ( Danube Refinery

G e e T e Developed Pl AF template that:

z
H
(=)
°

- g :::gz :;In?tt?:;n g & &F Curent 214.10000610351563 Categories: . ]
Default UOM: ! - o D t t I H 2
5 EdttSgyTeszt 4 8 ElDesc Ide kell 2 hosszi leiss erautd <Hone> etermine partia ressure
"0 o Hoorre e
5 Interlock Moritoring =] & Gasaln fiow §2.83045

-8 ow & bty 7 Value: 605.81629193204753 ° Attr'bute Of plpe Class
£} (5 DEKS IOW Data Reference:

- 3 Kénmentesis reaktor betép elimelegits caeppfogd - HTHA ] Gasolin molar flow kel |0.28879018023142428 N
(3 Kémentesireaktor betsp ekimelegts cseppfogd -Nyomss - setngs.. ] . Temperatu re and |ength of exposure limits
(5 Kénmentesits reaktor betdp/kiénd hécserdls - Hamérsékiet " E] Molar weight gjmol 20 =Partil pressure ps {5746+
- (@ Kénmentesits reaktor betép/képd hicserdld - Nyomés B | ‘ =1 H2 flow 11238, 164436340332 0.03015%A))+(3361484.8/A*2))] .
= D?FE??C‘JE\II(:V hidrogénezs reaktor betap elémeledits - ST e— ey ° Total tl me ab ove Tem p an d P P
(9 DGK3 10w

=1 HTHA limitF 605.81629193204753

bt P g e Alerts/notification/event frame

5 DKET 1OW
~ @ Sigfok - G Make upH2 254.211136

R T Rrwrer— i e Tested and rolled out in 6 units < 1 week

- (J Statistical Quaiity Control

!

( System =] Partial pressure 20.002323679218541
~ 6 Tarks
=] Partial pressure psi 290.03369334867028 H H
& Technology DataSheet ° E p d g | | pl 20 1 5
5 T e i Xpanding to a ants in .
-3 T
& ZalaRefinery < RecH2 11070.3193 Effect of Hydregen on Carbon Steel and
-~ (£}, Element searches , =1 Suruseg kg3 012 Lew Allayed Steels at High Temperature =L
e 420
a =1 HI Limit m Tomporature (*€}
(=] HTHA 318.7868288511375 02
Flement termal o
g & B ¥ Is operating 1 e internal del
miEvetiames = | = Lotmt -100000000 08
Libe
5 tibrary Y =] Name DBKSRTI2017.DACA.PY ol
e Unit of Measure
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L Shy
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Natural Gas Consumption Predictive Analytics

& Elements General [ Child Elements | Attributes |Ports | Analyses | Version |
mad BackGround e

& ARGUS
& Control loops DR =

- & Danube Refinery BN o :
& Energy Consumption Predictions

» Huge saving possibilities in the decrease of 5- o S

- [ DF C3 compressor stop

- . DF Fuel Oil Burning in BoilerPlant |’ ‘ = CoreSight Link I’m‘:‘mmwmwpL Ei
contracted natural gas daily maximum amount S orruoimoens

Category: Auxiiary Calculations
- [ DF GFR P8 BlowDown Increase

(& DF PE Own Burning AV2 = Category: Consumption Calculations.

3 DF PB Own Burning AV3 € ¥ cumulated Daily Consumption 18723164 M) E
- @ TVK GasTurbine Stop
(& TVK Gil Burning Increase % ¥ Current Consumption 1991855,5 MI/h 4
P ro b I e m : g E:f;;::;;ztsmm @/ & Predicted Dally Consumption 49276016 M3 E
(3 Flare Monitoring = Category: Exceedance Calculations
& 1ow
- ) Sisfok | 0‘ (] Alert State |4 ‘1
. . - g i::zm | 0‘ (=] HI Limit Excesdance |u M3 ‘1
 High penalty on daily amount exceedance T gy cotrent ST ———
. ( Tisza Refinery -
. d d . 6 Zola Refinery rd =1 HE Alert 53500000 M3 1
Alerting system was neede e (@ oo 1
= s =] LO Alert oMl 1
rd =1 LOLO Alert oM 1
SO|UtI0n General | Child Elements | Attributes | Ports | Analyses | version |
i) u
° H d H H I I H H Iy 1 e = MName Configuration Schedule QOutput(s) Backfilling = g
CO ns u m ptl O n p re ICtI 0 n Ca Cu atl 0 nS In P I Ana SIS (] fea Auiliary Calculations RemainingDayRatio := In... Frequency=120... RemainingDayPart; RefD... 4
° H d H M 1 g d H p y (] fisw CumulatedDailyConsumption  CumulatedDailyConsump... Frequency=120... Cumulated Daily Consum... (] 1
DEtalle Informat'lon On PI. C.0reS| ht IS Ia‘ (] fia CurrentConsumption CurrentConsumption := T... Frequency=120... Current Consumption (] 1 A
(about consumption, prediction, contacts of © /B PrdiedDadGonsumpion  SecondToNextGeDayT..Frequerey=120.._ redicted Doty Corrp @ L

decision makers)
» E-mail alerting system in Notifications = Expresion

SecondsToNextGasDayTurn | Int(Bod( ' *-6h" )+ +30h"-"*")

PredictedDailyConsumption

‘Cumulated Daily Consumption'+'Current Consumption'*SecondsToNextGasDayTurn/3668

Add a new expression
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Energy Demand Forecasting with Future data

©ﬂpﬁ§§?}?i‘-‘“' IQ | ] [ v ‘ 0] UC2014- 2 hours: W : m .
Improve energy trading by
®  Exterior Temperature|Forecasted | © Exterior Temperature|Measured |

52.133 *F 52233 r

Collect real-time data

Train energy consumption models

51

50.5

Predict energy consumption based
on production plan

50

49.5 |
4/8/2014 5:21:14 AM I?:Z}.:O? AM +59m 52s| 4/5/2014 8:21:14 AM

afsfaoneziasan | (3] [8h] [1d] (1] [ime] [l [#/sizszamarisan

Monitor and update models
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Enabling Analytics for Operational Intelligence

Real-Time Decision Analysis Retrospective & Predictive Analysis

Pl Integrator for
Business Analytics

Time and Event

Trending & Awareness Multidimensional
Business Intelligence

& Dashboards

Specialized Models
Simulation & Optimization

APDD * kh

9= 141.2p30{zn;—; —-34 s} l-

First Principles
Performance
& Condition

s e

L] £ [+ sstans
g. r t‘l Jan E:ES ‘!J l.l‘\" scored Labal

Time, Event Tabular
and Asset Context
Context

Statistical
Predictive Modelling
& Machine Learning
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Pl Integrator for Business Analytics - “Select Data”

Compressor Analysis

¢ NOW avallable Select Data ? Modify View 2 Publish Next

@ Source Assets I, Asset Shape Matches
° Create “ P I Vl eWS” Server CHERTLERG430S T Shapes Found 29 Matches
H Database Compressors @ Compressor Vs @ Compressor-023
fro m AF H Ie rarC hy # Differential Pressure Va @ Compressor-304
@ Compressor-340
4 € GasTran # Gas Flow 4 @ Compressor-356
. Model Ve @ Compressor-432
e Select AF Elements | 22 B siton s x| O compresarser
| ) Compressor-023 @ unito1
1 @ Unitol
and Attributes T & o>
@ Compressor-340 @ Unito2
. &) Compressor-356 @ Unito3
« Scale up leveraging & compresor 12 © uuws
— Unit04

name, hlerarchy’ or Attributes [ 7rer SB:E:

@ Unitos

Category 0 select Al S

Differential Pressure
hd @ Unitos

4 Gas Flow @ Unito7

=] Model @ unito7
@ unito7

Station
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Pl Integrator for Business Analytics - “Modify View”

Compressor Analysis

® Column Details

¢ SeIeCt any tlme Select Data > Modify View > Publish Name

range and interval S — — = Sebow __ |
i eset Name to Defau
6 Columns 0 Row Filters Rzﬁliiﬁ:‘:lues _Saturday, October[%l

Data Content @

Compressor | LocalTime Differential Pressure Gas Flow |

° Ad d COI umns fo r Unito1 2011-10-01 00:00:00 93.3822 100.6735 Model A
. Unit01 2011-10-01 00:01:00 93 36484 1006739 Model A
roper ag g re g atl n g Unit01 2011-10-01 00:02:00 93 34747 1006742 Model A
P | Syste m d a‘t a Unit01 2011-10-01 00:03:00 93.33011 100.6746 Model A
Unito1 2011-10-01 00:04:00 93.31274 100,675 Model A
Unit01 2011-10-01 00:05:00 9329539 100.6754 Model A

° Ad d I f Unit01 2011-10-01 00:06:00 93.27802 1006758 Model A -

columns tor Unit01 2011-10-01 00:07:00 93 26066 1006761 Model A encRie BEvten o
. Population Standard Deviation

common tl me an d Unit01 2011-10-01 00:08:00 9324329 1006765 Model A
d t f n t n Unit01 2011-10-01 00:09:00 9322593 100 6769 Model A
ate runctions Unit01 2011-10-01 00:10:00 93 20856 1006772 Model A
Unit01 2011-10-01 00:11:00 93.1912 1006776 Model A
Unit01 2011-10-01 00:12:00 93.17384 100,678 Model A
Unit01 2011-10-01 00:13:00 93.15647 100.6784 Model A
Unit01 2011-10-01 00:14:00 93.13911 100.6787 Model A
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Pl Integrator for Business Analytics - “Publish”

. SeIeCt targeted Select Data > Modify View > Publish
endeInt “PI VieW"’ Target Configuration Summary

MS SQL’ File’ more | P1 view Shape and Matches
to Come P ) Run Once + There are 23 Matching Instances.

Timeframe and Interval
® Run on a Schedule

« Your Start Time is Saturday, October 1,
First Run 2011 12:00:00 AM

 Publishonceoron [ ] | e e Nt

201 12:00:00 AM
4 Nov 2015 » = Your Time Interval gets an interpolated

a scheduled bases N A

S0 Mo Tu We Th Fr  Sa

25 26 27 28 29 30 3
12 3 4 5|6 7 “

a8 9 o n 12 13 14

% 1B 17 1|8 19 20 21
22 23 24 25 26 27 28

23 30 1 2 3 4

Hour Minute Second

0o|v] 0o[v| 00)v|
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Enabling Analytics for Operational Intelligence

Real-Time Decision Analysis Retrospective & Predictive Analysis

Pl Integrator for
Business Analytics

Time and Event
Trending & Awareness

Multidimensional
Business Intelligence

Specialized Models & Dashboards

Simulation & Optimization = —
APpp * kh S S8 S S P A% o p
e P g . N N
aa “{ mrTat } Time, Event Tabular EerREEa — '
: . and Asset Context Statistical =
FITSCEITHCINIES Context Predictive Modelling

Performance

& Condition & Machine Learning
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Statistical Analytics - Example: Power Forecast

Predicted Power = 0.2324 * Average( Actual Power, 1 day ago, +/- 5 min) +

0.1421 * Average( Actual Power, 2 days ago, +/- 5 min) +
.......... (terms for 3-13 days ago)......

0.0435 * Average( Actual Power, 14 days ago, +/- 5 min)

« Statistically derived e

equation with coefficients b
and time relative averages y | ! Pp

« Configurable in Pl AF with . H

backfill to assess l ‘ % wh

e Schedule in PI AF to W’
provide forecast - Pl Sever
future data

€6 % days 5 T
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Statistical Analytics - Predictive Modelling & Machine Learning

 Complex systems where first
principles equations interact or

don’t exist il

Linear Regression

« Empirical or “fitted” models |
generated from time, event and Neural Network Regression
asset data in tabular context =

Boosted Decision Tree Regression

* Predicts outcome,

e.g. equipment failure,
unmeasured or forecasted R 4 SS&S«
guantities

Multiclass Decision Jungle MATLAB

e Model continuously improves or
“learns” with additional data
Microsoft Azure
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Enabling Analytics for Operational Intelligence

Real-Time Decision Analysis Retrospective & Predictive Analysis

Pl Integrator for
Business Analytics

Time and Event
Trending & Awareness

Multidimensional
o Business Intelligence
Specialized Models & Dashboards

Simulation & Optimization

Q _ APDD: kh3 e — == . L& gﬂg g Eﬂ#‘ﬁi&. i
141.2uBy {In 7= —§ + 5 Time, Event Tabular R m
: .. and Asset Context Statistical
FII’FS);E::;I;I(E)JGS Context Predictive Modelling
& Condition & Machine Learning
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Multidimensional Analytics — Business Intelligence

Actual Inlet Flow Rate, ft}/min

« Ad hoc, visual analysis of om0 4T g T e

a table or related tables of Sl [

data 1] i Py

a 12000 Best Efficiency Point 39368 §

* COIumnS aggregatEd for 1mm?10000 12000 14000 16600 18000 2060;2808

selected rows, presenting Al e i i

results in a variety of ways Compressor Performance - Pressure vs. Flow
« Excellent tools for o

personal analysis and

enterprise reporting and

dashboards
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Multidimensional Analytics — Time Contextualization

Flexible, repeatable access to high
fidelity operational data

Sampling Increment Comparison

Engine Speed, rpm

« Time relative aggregations and
statistics at any interval

« Juxtaposition of values -
published rows can contain
previous row’s value.

» Backfill First Principle facts as
best practice
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The Most Advanced Refinery in the World by 2020

YASREF (Yanbu Aramco Sinopec refinery JV)

“Selecting the Pl System and EA early supported a smooth refinery o
start up and set the foundation for an integrated, collaborative data based Yasref

decision making culture that supports YASREFs vision of being \V///
the most advanced refinery in the world by 2020.”

UC2015

Mahmoud M. Madani, IRIS Lead Project Engineer

23 separate applications from a YASREF strategically chose the The market responds to quick
variety of vendors including PI System as an integration ramps of energy production
DCS; aggressive grassroots and applications infrastructure and maintains grid reliability
schedule applications

» Lack of collaborative, data based « Migrated standalone applications  Eliminated over 50% of the
decision making USIng standard to the infrastructure with Pl AF standalone applications
DCS supplier approach . :
» Used Microsoft platform to » Enabled a very smooth refinery
+ Weak data and analytical provide advanced web based startup
foundation to enable OpEx and reporting and decision support .
e Provided KPIs and performance

continuous improvement | ]
reporting foundation for OpEx
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Performance Management System

B nttp://vdeviapcol00/irep/pms/Pages/default.aspxidashboard O = ¢ X @ Performance Management ... %

Performance Management System

Yowet I
Yasref

£33 PlannedVsActualProduction

Financial = OME  ~ HSE ~ Human Resource ¥

w Filters

WIEW

Unit Production by Product - Month to Date

I Month Year
[0

PM3 Unit Name

MTD Actual Production {(MT) MTD Actual Vs Planned Production (MT}

b BMS Unit Mame
Leval 02 s, Linknown of Nere

I uen At rediczen T IR Punned Production MT

- o
Rsste

s orzs [

g s s | ——

e ey =

. g

IPR———— =
s o e
——————

o L) tam [E] LE) osm

MTD Actual Vs Planned Production

-

~
Resiue Intamadans) | |

e ot prnermnein) () oy
Wi Diszllines Imermresate) @

e
E=
s
are Jas Brsaemoaciats)

150K -
o Piapinhs (ncemmedlate)

s
Y
o B8

o s 100¢ 120 H0e sa0¢ ok e Ees E=

Manage Configuration

v

9350

)/ 4
_ﬂr_...;L
Yasref

Brodskiy Alexander =

) SHARE 17 FOLLOW OO,

-

Search this site yel ‘

== kPl Definition

KPI Name Flanned Vs Actual Production

It is a measure of the deviation between

KPIL the planned and the actual preduction for
Defination the day.

Formula = [{{Actual Production (MT/day) —
Target Production (MT/day])]/ Target

m

Formula

Production (MT/day)) * 100

» Planned production per unit per day(MT)
Data from PIMS SROP plan
Source  * Actual production per unit per day(MT)

from RMB VALL

Daily calculation , monitoring and
Frequency reporting.

Trending Greater Than Zero Green;

and Between -1.0% to Zero Yellow;
Status ) Than -1.0% Red:

Ranges

") osisoft. REGIONAL SEMINARS 2015
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Enterprise Performance Summary

Oil and Gas Operations & Share Dashboard

| Ask a question about the data on this dashboard

Exploration & Production Refining Distribution
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Driving Continuous Improvement

Y

Organizational ~ —- —=_ - — = -
Insight !l _E S22

Access

Content

Lubiy - [T (2

Personal
Analytics &
Assessment

Collaborative ~— ¢~ -
Intelligence T =

Mobility &
Socialization

Data with Context Action

W

Operational
Awareness

e
i

lation
i [ Cadereyta V
ade

Pl Integrator for BA | L5357 Pl System
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Detailed Reporting and Analytics

L L

Dashboard drilldown —— '_a
to detailed reports = — -

Pl Coresight

Regional SEMonth Inventaries

gl | | oo |FE

Regional
Product
Inventories

Production =
Summary

Refinery

KPI Scorecard ..m..|l|||i||||||1|III|”||||||||‘Im||H||I||”|H”||||Im|I||||..........._____

Drilling Activity Asset Performance
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Summary and Wrap Up

 The Pl System enables all types of operational analytics by providing

time-related data supported by the essential foundation provided by Pl
Asset Framework.

* Look holistically when selecting an analytical method or methods. PI
Analytics is very capable of performing equation-base analytics for
performance and conditions assessment, as well as, certain types of
predictive analytics.

 The PI Integrator for BA establishes “Common Ground” between OT and
IT contextualization's enabling Operational Intelligence.
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Contact Information

Curt Hertler
curt@osisoft.com

Global Solutions Architect
OSlsoft, LLC

Craig Harclerode
charclerode@osisoft.com
Industry Principal — Oil & Gas
OSlsoft, LLC
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Questions Please don’t forget to...

Complete the Survey

Please wait for the . .
for this session

microphone before asking
your questions

Evaluation Form (Seminar Location - Date)

Name: Company:

Email:,

Quality and content of the presentations

{
o
14

O00O Q000
OO0 O 0000 §

Welcome

The Journey To Real-Time Operational Intelligence
The Pouser of Connection

Tank Level Management System

Using the Pl System to Aid in Troubleshooting Operational Aspects of Oil
and Gas Well Drilling and Complefion

Unleash your Infrastructure

State your
name & company

Information on the Spot

000 00000 |
000 00000 £

Wrap-up/Seminar Conclusion

Quality and organization of the seminar

Choice of date O @] o O
Time allowed for lunch/breaks O O O O
Choice of presentations @] O O O

matinR Sn $n AR —~ —~ — —~
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Danke ,
Merci Gracias
Thank You
HOhES
Cnacubo Obrigado
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